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CHAPTER 7

RESOURCING CONCEPTS

INFOCUS
WPL_J406

Microsoft Project’s primary purpose in life is to act as a scheduling tool – you
enter a few tasks and assign a few resources to those tasks and hey presto – a
schedule is created for you which outlines appropriate start and end dates not
only for the entire project but also for its tasks.
You can elect not to use this powerful aspect of Microsoft Project by leaving your
project and its tasks in manual scheduling mode. However, in the real world most
users of Microsoft Project want to see what happens when tasks are delayed, or
when you assign more resources to a task, or when a contractor can’t start on the
day required. All of these require that some or all of the tasks be auto-scheduled
so that Microsoft Project can apply its internal calculation methodologies to derive
relevant scheduling outcomes.
Once you auto-schedule tasks start and end dates miraculously (and sometimes
mysteriously) move in and out as you manipulate and play around with your
resource assignments. Understanding the underlying methodologies, how they
work, and what outcomes they will generate is fundamental to keeping frustration
levels with Microsoft Project to tolerable levels.

In this session you will:
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gain an understanding of how resource assignment
calculations are made
gain an understanding of the varying task types and work
effort
learn how to perform simple resource assignments
learn how to work with fixed unit tasks
learn how to work with fixed duration tasks
learn how to make multiple assignments of resources in a
Task Form
learn how to add additional resources to a task and
handle the consequences
learn how to add more of the same resource to a task
and work with the consequences
learn how to add more of the same resource where
multiple resource types exist
gain an understanding of effort driven scheduling
learn how to work with tasks that are not driven by effort
learn how to work with effort driven tasks.
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RESOURCE ASSIGNMENT CALCULATIONS
When tasks are auto-scheduled, their start and
end dates can be manipulated both by the task
duration and the assignment of predecessors.
Once resources are assigned to tasks, other

variables come into play which can affect their
scheduling. Key amongst those variables are the
number of resources (known as units) and the
amount of work required by those resources.

The Scheduling Triangle
Auto-scheduled tasks are controlled using three factors – duration, the number of resources, and
the amount of work required by those resources. Generally you start a project with tasks and then
assign durations to those tasks.
For example, you may want to paint the inside of your house which you assume will take a week to
do. Let’s say for the sake of this example that a week is made up of 5 working days, each 8 hours
long. So the duration of the task is 1 week (i.e. 40 hours). The task form for this example would look
as follows:

George the painter has been hired to do the work. As soon as you assign George to the task your
task form will appear as follows:

Important assumptions have been made here by Microsoft Project based on what was just entered.
Notice how the work field shows 40h. This has been calculated from the number of units (100%)
multiplied by the duration (1w = 40 hours). In this example the formula used by Microsoft Project for
determining the amount of work required by George is:
Work = units x duration (40 = 100% x 40)
So, we have told Project that the task will take 1 week (i.e. 40 hours) and we’ve told Project it will
take George 100% of his time to do it. Microsoft Project in turn has determined from this that there is
40 hours of work required by this resource to complete the task.
Once initial values are entered the calculation wheel is truly in motion. But what happens if we clone
George and assign him and his clone to the task? In this scenario Microsoft Project can either:


halve the duration ( 20h of duration = 40h of work / 2 units of George)

or
 increase the work value to 80h (80h of work = 2 units of George x 1w duration)
As a default Microsoft Project will change the duration first. Therefore, if we assigned another
George to the task above, the duration would halve from 1 wk to 0.5 wks (i.e. 40h to 20h).
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TASK TYPES AND WORK EFFORT
With auto-scheduled tasks the scheduling will
update when one of the three resource variables
– duration, work, or units – are changed.
Microsoft Project affords you a greater degree of

control over what will be allowed to change through
the use of task types. You can lock a task into
being either one that is fixed duration, fixed unit,
or fixed work.

Task Types
The really neat thing about Microsoft Project is that while it needs all three points of the assignment
triangle – duration, work, and units – to perform the appropriate calculation, it is happy to fill in the
missing pieces should you leave one blank. Generally, you’ll know the duration of a task and the
resources you wish to assign to it. With this information Project can calculate the work and enter it for
you.
However, once you have a handle on this, or if you want to specify the work yourself, you can play
around with the calculation methodology to get it to do what you want. At any point in time one of three
points of the assignment triangle is fixed, effectively allowing the other two to be manipulated.
As a default the Units are fixed because Project’s default calculation bias leans towards changing
durations first, then work, and finally units. You can, however, override this bias by fixing one of the
other points. The consequences of this are outlined in the table below.
Task Type

Usage

Impact

Fixed Units

This is the default setting. It means
that Units will not be altered.

Change duration and the work will adjust

Use this setting if the duration must
remain constant.

Change units or duration and the work will adjust

Used when work is to remain constant.
For example, when a specific amount
of work has been quoted and will be
charged for irrespective of resources
used or duration.

Change units and the duration will adjust

Fixed Duration

Fixed Work

Change work or units and the duration will adjust

Change work and the units will remain unchanged

Change duration and units will remain unchanged

Resource Work
While simple, single resource examples are fine and relatively easy to understand, the waters get a
little murkier when several resources are involved. For example, let’s say that erecting the framework
of a house takes six weeks. This translates to 240 hours given an 8 hour working day (6 x 40 hours per
week). The work required for the following resources is:
Resource

Units Assigned

Work

Resource Duration

Work Formula

Carpenters

500%

1200h

240h

5 * 240

Labourers

800%

1920h

240h

8 * 240

Driver

100%

240h

240h

1 * 240

Supervisor

25%

60h

240h

.25 * 240

All resources above have been assigned to work for the duration of the task (240 hours). The
supervisor works one quarter of each day (during the entire task), while the other categories work the
full day.
As you can see work should not be confused with duration – work is the total number of hours
required by the resource units to complete the task in the duration. So while carpenters will be taking
240 hours to complete the task, because there are 5 (500%) carpenters there is actually 1,200 hours of
carpenter work effort required to complete the task within 240 hours.
The total work required by all of the resources is known as the effort. A task can be effort driven
where the total amount of work controls the scheduling.
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CREATING A SIMPLE ASSIGNMENT
The best way to see how the calculation of work
effort is performed is to create a relatively simple
assignment in a project. We will step out of the
case study for the remainder of this chapter and

Open File

Try This Yourself:









play around with a simple project. One of the best
ways to assign resources and to see what is going
on is to use a split view incorporating a Task Form.

5

Before starting this
exercise you MUST
open the file J406
Assignment
Concepts_1.mpp...
Click on the View tab of
the Ribbon and click on
Details in Split View to
see a Task Form in the
lower part of the screen
Click on the Task Form
bar at the left of the
screen

The Assign Resources dialog box allows you to assign
resources to the task that is selected. Its other advantage is
that it lets you see the resources available to your project.

Click on the Format tab
on the Ribbon and click
on Work in Details to
see the Work settings in
the form
Click on Paint Building
A in the Gantt Chart
Click on the Resource
tab on the Ribbon and
click on Assign
Resources to see the
Assign Resources
dialog box
Click on Supervisor
and click on [Assign] to
assign this resource

In this example we have assigned the
Supervisor to the task. The task has a duration
of 1 week, which in this project file is equivalent
to 37.5 hours. That is why the Work column
shows 37.5h.

6

Click on [Close] to close
the Assign Resources
dialog box

For Your Reference…

Handy to Know…

To assign a single resource to a task:
1. Display the appropriate view and select the
task
2. Click on the Resource tab and click on
Assign Resources
3. Click on the resource and click on [Assign]

 A split screen is made up of an upper and
lower pane. The bar at the left of each pane
is used to select the pane you want to work
with. Commands on the Ribbon sometimes
change according to the pane and the view
that is currently selected.
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WORKING WITH FIXED UNIT TASKS
automatically update, or if you change the work
hours, the duration will automatically update.

As a default, new tasks entered into Microsoft
Project are created with the Fixed Units type
classification. This means that once entered, if
you change the duration the work hours will

Same File

Try This Yourself:



Continue using the
previous file with
this exercise, or
open the file J406
Assignment
Concepts_2.mpp...
Select 1 wk in
Duration in the
Task Form, type
2w and click on
[OK]

1

Because the Task type is Fixed Units, the Units of resource has
remained at 100%. The work however has doubled because the
duration has changed to 2 weeks (100% x 37.5h x 2).

Here we’ve
changed the
duration. Let’s alter
the work hours this
time to see what
happens to the
duration...





Click on 75h in
Work in the Task
Form
Type 56.25h and
click on [OK]
Click on 56.25h in
Work, type 37.5h
and click on [OK] to
reset the values

3

Since the Units are fixed at 100% and we have changed the work
to 56.25h the only variable that can change is the duration. The
duration has changed to 1.5 weeks (1 supervisor x 56.25h)

For Your Reference…

Handy to Know…

When a task is Fixed Unit:

 If a task is set with a Fixed Unit task type
you can still adjust the number of units.
When you do this Microsoft Project will, as a
default, make changes to the duration.



If you change the Duration, the Work will
automatically update



If you change the Work, the Duration will
automatically update
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WORKING WITH FIXED DURATION TASKS
There are some tasks that need their durations
fixed. Fixed Duration type tasks are normally
ones where the duration won't or can't change
because the events that shape the task are

1

Same
File

Try This Yourself:




outside of your control. Since the duration is fixed
changes made to these tasks don’t normally
interrupt the schedule. However, they often create
problems of insufficient resources for the task.

Continue using the previous
file with this exercise, or open
the file J406 Assignment
Concepts_3.mpp...
Click on the drop arrow
for
Task type in the Task Form,
click on Fixed Duration and
click on [OK]
Click on 100% in Units, type
200%, and click on [OK]

4

There is only 1 supervisor
in the whole project. The
message here indicates
that we’ve assigned 2
supervisors which
obviously can’t be done.

At first glance it appears as
though things have worked.
Units have increased as have
the work hours. However a
resource problem indicator has
appeared next to the task
name suggesting that we have
a resource allocation
problem…




Three solutions are offered
to us. We can:
1. Increase the duration –
since work is now 75h
the duration will need to
be increased to 2
weeks.
2. Reduce the work – it
can be no more than
37.5h.
3. Assign another
resource.
You can click on any of
these options and Microsoft
Project will make the
necessary adjustments.

Hover the mouse pointer on
the indicator and read the
(cryptic) information that
appears
Right click on the indicator and
click on Fix in Task Inspector
to see a new panel appear at
the left
This panel explains the
problem and suggests relevant
fixes…



Click on [Reduce Work] to
restore the work back to 37.5h
and the units to 100%

For Your Reference…

Handy to Know…

When a task is Fixed Duration:

 When we instructed the Task Inspector to
repair the problem by reducing the work the
units also reverted back to 100%. This
occurred because the problem we were
fixing was an over allocation of resources – it
reverted back to the available number of
units.



If you change the Units, the Work will
automatically update



If you change the Work, the Units will not
change
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MAKING MULTIPLE ASSIGNMENTS
Planning before you hit the keyboard is what
success in Microsoft Project is all about. Often
tasks will require more than one resource
assignment. Careful planning should reveal to

Open
File

Try This Yourself:
Before starting this exercise
you MUST open the file J406
Assignment
Concepts_4.mpp...



Click on Paint Building A in
the Gantt Chart

you what resources are required before you set up
your project. If you know the resources that will be
required it is best to enter them directly into the
Task Form in one operation.

2

There are currently no
assignments here…



Click in Resource Name in the
form, click on the drop arrow
and click on Supervisor

3

The assignment still has to be
recorded. This is done later
after we’ve added all of the
resources…




Click directly below the
Supervisor in Resource
Name, click on the drop arrow
and click on Painter

5

Click in Units next to Painter
and type 300%
This represents 3 painters
working for the entire
duration…



Click on [OK] to record all of
the assignments
Notice that there are 37.5h for
supervisors, and 112.5h for the
painters in work

For Your Reference…

Handy to Know…

To make multiple assignments:
1. Click on the Resource Name drop arrow in a
blank row in the Task Form and click on the
desired resource
2. Once all of the resources have been listed
click on [OK]

 Only when the [OK] button is clicked does
Microsoft Project record the total effort for
the task. The effort is simply the sum of all of
the work. In this example the effort will be
150h (i.e. 37.5 + 112.5 hours).
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ADDING ADDITIONAL RESOURCES
There will be times when you need to make
adjustments to the current resource assignments
of a task. This can escape the original planning
phase and occur for all manner of reasons.

3

Same
File

Try This Yourself:





Depending upon the type of task you are working
with this may have interesting implications for your
schedule. When implications become apparent
Microsoft Project will provide you with options.

Continue using the previous
file with this exercise, or open
the file J406 Assignment
Concepts_5.mpp...
Click on Paint Building B in
the Gantt Chart
Click on the Resource tab on
the Ribbon and click on
Assign Resources in
Assignments

4

Click on Supervisor and click
on [Assign]
So far so good. But let’s see
what happens when another
resource is assigned…



Click on Painter in the Assign
Resources dialog box and
click on [Assign]
A triangle appears at the top
left of the task indicating that
there are a couple of ways of
handling this…



Click on the triangle to see an
Action Button
and click
on the button to see the
options

5

We want the supervisor and
painter both to work 37.5h
each…



Click on Increase total work
because the task requires
more person hours to resolve
the problem

6

For Your Reference…

Handy to Know…

To assign additional resources to a task:
1. Click on the Resource tab on the Ribbon
and click on Assign Resources in
Assignments
2. Click on the desired resource and click on
[Assign] – look out for triangles

 In this example we initially assigned a
supervisor at 37.5h. When we subsequently
assigned a painter Microsoft Project wasn’t
sure whether we wanted the total effort kept
at 37.5h or whether we wanted both to work
at 37.5h each for a total effort of 75h.
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ADDING MORE OF THE SAME RESOURCE
If you add or remove resources using the
Resource Assignment dialog box Microsoft
Project will try and help you overcome potential
problems or scheduling issues by displaying a

Open
File

Try This Yourself:





triangle and an action button with suggestions and
strategies. This doesn’t occur when you add
resources by typing directly into the Task Form.

3

Before starting this exercise
you MUST open the file
J406 Assignment
Concepts_6.mpp...
Click on Paint Building A
and notice that it has 1
painter assigned to it
Click on the Resource tab
on the Ribbon and click on
Assign Resources in the
Assignments group
Click on 100% in the dialog
box, type 200% and press
Because this is a Fixed
Units task the total work
has remained at 37.5h and
the duration has halved.
But there is also the
triangle in the task name…



Click on the triangle and
click on the Action Button
to see the options you
have

4
5

The default in this case is
actually fine…



Click on Change the
duration so resources
spend only the specified
hours/day working on the
task to confirm that the
right choice has been made

For Your Reference…

Handy to Know…

To increase resources using a dialog box:
1. Click on the Resource tab on the Ribbon
and click on Assign Resources in the
Assignments group
2. Increase the current percentage shown for
the resource and press

 Choosing the Change the task’s total
work… option would have resulted in the
Work increasing to 75h but the duration
remaining at 1 wk.
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MORE RESOURCES IN MULTIPLE ASSIGNMENTS
Adding more resources to a task should normally
reduce the duration of the task – after all, many
hands make light work. But Microsoft Project has
issues when you add more of one type of a

1

Same File

Try This Yourself:





resource where other resources are also present. It
doesn’t know whether you are trying to shorten the
duration, or simply add more resources because
more work for a resource is required.

Continue using the
previous file with this
exercise, or open the file
J406 Assignment
Concepts_7.mpp...
Click on Paint Building B
and notice that it has 1
painter and 1 supervisor

3

If necessary click on the
Resource tab on the
Ribbon and click on
Assign Resources in the
Assignments group
Click on 100% for Painter
in the dialog box, type
200% and press
Okay, so nothing appears
to have happened – or has
it? Even though the
duration and the work
remain the same Project is
saying that there are now 2
painters working a total of
37.5h – in other words they
are job sharing doing only
18.75h each on the task…




Click on the triangle in
Paint Building B and click
on the Action Button
to
see the options you have
Click on Change the
task’s total work (person
hours) to match the units
and duration

4

5

For Your Reference…

Handy to Know…

When adding resources in multiple assignments:
1. Use the Resource Assignment dialog box
to add the resources
2. Use the task’s Action Button
to work out
the best option for your project

 In this task the work assumed originally per
resource was 37.5h. Even though more
painters were added to the task the
supervisor was still required to work 37.5h.
Microsoft Project therefore retained 37.5h as
the work for the painter but split this between
the two when we added the extra painter.
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UNDERSTANDING EFFORT DRIVEN SCHEDULING
It is safe to assume that if you add another
carpenter to a task that already has a carpenter,
then the duration of the task should reduce
given that the same amount of work is now

handled by two carpenters. However, should the
duration change if you add a labourer to that task?
If the answer is yes, then you will need to consider
changing the task to effort driven.

Work Driven Scheduling
In Microsoft Project the terms work and effort apply to two very different things. Work is a
measurement of the time that it takes resources to complete what is required of them in a task. Work is
usually measured in hours, and the resource in a task that has the most work (hours) is the one that
normally controls how long the task will take (the duration).

In the example above we have a carpenter who requires 40h to complete the task and a supervisor
who requires 40h. The duration is determined by the longest amount of work, which in this case is 40h,
and it is calculated at 1 week (assuming a 40 hour week).

We’ve now added another carpenter and also a labourer. Adding the carpenter resulted in no change
to the amount of work – however, each carpenter job shares and works only 20 hours. The duration
hasn’t changed because the supervisor had the greatest amount of work after the second carpenter
was added. When we subsequently added a labourer Microsoft Project assumed that the labourer
would work the duration of the task (40 hours).

Effort Driven Scheduling
Using the same example above we get a very different result when we convert the task to Effort
driven before making the changes. When we convert the original task to effort driven Microsoft
Project totals all of the work to derive an effort value. In the original schedule effort will be 80 hours
(40h + 40h). If we now add another carpenter and then a labourer the work values appear as shown:

Here the 80 hours of effort remain constant. Since the carpenters are both job sharing they are
counted as 1 resource, not 2. Therefore, there are 3 resources counted here (1 job-sharing
carpenter, 1 supervisor, and 1 labourer). Dividing the total effort (80 hours) by 3 provides work hours
for each resource (26.67h), and since this is now the longest work value it controls the duration.
Here all resources share the effort. Since the effort is fixed, the more resources, irrespective of type,
we throw at the task the shorter the task takes to complete.
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WORKING WITH NON EFFORT DRIVEN TASKS
In Microsoft Project 2010 new tasks as a default
are created as non-effort driven. In other words
the duration calculations are determined by the
individual resource work loads as opposed to the

1

Open File

Try This Yourself:





Before starting this
exercise you MUST
open the file J406
Assignment
Concepts_8.mpp...
Click on Build the front
walls and notice that a
carpenter and a labourer
have been assigned to
the task for 6 weeks
Click on the Resource
tab on the Ribbon and
click on Assign
Resources in
Assignments
Click on Electricians
and click on [Assign]
Here the total hours of
work have been
increased from 480h to
720h but the duration
remains intact…




total work (or effort) of the task. This allows you to
freely assign additional resource types without
impacting too much on the work loads of the other
resources.

Click on the triangle in
Build the front walls
and click on the Action
Button
to see a list
of options

4
5

Click on Increase total
work… to accept the
default changes

For Your Reference…

Handy to Know…

To work with a non-effort driven task:
1. Ensure that the Effort driven setting in the
Task Form is not ticked
2. Enter assignments as required

 The total work (the sum of all of the work
required by the resources) is the same as the
task effort. When tasks are not driven by
effort the amount of total work can freely
increase.
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WORKING WITH EFFORT DRIVEN TASKS
If throwing additional resources will affect the
duration of a task, then the task should be
marked as effort driven. This is done by ticking
the Effort driven setting in a Task Form. When

Same File

Try This Yourself:




you mark a task as Effort driven the total work
times of the task are summed to create an effort
value which is then used to control the overall
duration as the resources are updated.

2

Continue using the previous
file with this exercise, or
open the file J406
Assignment
Concepts_9.mpp...
Click on Build the back
walls and notice that a
carpenter and a labourer
have been assigned for 6
weeks
Click on Effort driven in the
Task Form and click on [OK]
This now sets up a total effort
of 480 hours (240h + 240h)…



Click back on Build the back
walls, click on Electricians
in the Assign Resources
dialog box and click on
[Assign]
The duration will decrease to
4 weeks because the 480
hours of effort is now being
done by 3 resources rather
than 2 meaning that each
resource only needs to work
160 hours…




4

5

Click on the triangle in Build
the front walls and click on
the Action Button
to see
a list of options
Click on Reduce duration…
to accept the default changes

For Your Reference…

Handy to Know…

To make a task effort driven:
1. Click on Effort driven in the Task Form
2. Click on [OK]

 Effort driven is really only relevant for tasks
that have more than one resource
assignment. With only one assignment
duration is automatically recalculated when
work or units change.
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RESOURCE ASSIGNMENT SUMMARY
A lot of theory has been covered in this particular
chapter and it probably doesn’t hurt to summarise
the key points that have been covered. Much of
what we’ve addressed here will become more

familiar and probably more logical as you work
through your own projects.

Resource Assignment Calculations
Resource assignment calculations in Microsoft Project are based on three elements – duration,
work, and resource units. In the equation, duration will be adjusted first where possible, then units,
then work. The calculation can be algebraically re-defined as follows:
Work = Duration x Units
Duration = Work ÷ Units
Units = Work ÷Duration

Work is normally shown in hours, and Units (the number of resources) as percentages.

Task Types
Tasks must be assigned one of three possible types – Fixed Units, Fixed Duration, or Fixed Work.
As a default a new task is created as Fixed Units. The type assigned to a task determines the
scheduling calculation that will be performed by Microsoft Project on the task.

Learn To Use, Not Abuse
It’s all too easy to become frustrated with Microsoft Project’s scheduling methodologies. Keep an
eagle eye out for little symbols such as the over-allocation symbol that appears in red in the
information column on a task sheet, or the little triangle that indicates an Action Button
is
available to guide you through troubled waters. These symbols and icons can usually be clicked or
right-clicked to reveal automated actions or inspectors that offer advice.
Consider using the Assign Resources dialog box for entering resources as this dialog box will
trigger Action Buttons for you.

Effort Driven Scheduling
Effort driven scheduling is where the total work effort of a task remains fixed irrespective of how
many resources you throw at the task. The total work effort is derived by summing all of the work
done by the resources.
Since the total work remains fixed the duration of the task will be shortened when you add more
resources and lengthened as you take them away.
Effort driven scheduling is turned off in Microsoft Project 2010 but turned on in previous versions.
As a rough rule of thumb if you have a task where the duration should reduce the more resources of
any kind that you throw at it, then it should be set up as an effort driven task.

Adjust Your View
When allocating resources to tasks adjust the views of your project to provide as much information
and easy access to features as possible. While you are beginning we suggest splitting the screen so
that a Gantt Chart appears at the top and a Task Form appears below. The Gantt Chart will allow
you to see your tasks in a task sheet on the left, and as a timeline at the right – the timeline is a
great way to perceive scheduling changes. The Task Form at the bottom provides an easy way to
adjust resource allocation details. You can use options on the Format tab on the Ribbon to tweak
the settings in the Task Form.

Expect the Unexpected
Keep an open mind and a calculator by your side when working with Microsoft Project. It hardly ever
gets things wrong – but it can take a fair while sometimes to try and work out what it is doing,
especially with work calculations.
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